# Index

## Knowing the Environment
- Drag and Drop ................................................. 4
- Sprite Concept .................................................. 6
- Preparing a Custom Sprite ............................... 6
- Modifying the Textures of the Sprite Elements ....... 8

## Project
- Project Settings ............................................... 10

## Defining Your Own Actor
- Mix-matching Composite Characters from the Library 12
- Head Types in CrazyTalk Animator ..................... 12

## Customizing Your Actor With Character Composer
- Changing Parts of a Character ............................. 13
- Using Predefined Sprites to Compose a Face .......... 14
- Changing the Layer Order - Body Parts and Facial Features 15

## Creating Custom Actors from Photos
- Creating a Face from a Photo ............................ 16
- Image Processing ............................................. 17
- Automatic Image Fitting ................................. 17
- Face Fitting .................................................... 18
- Generating a Body from a Photo ......................... 28
- Image Processing ............................................. 28
- Editing the Background Mask ......................... 29
- Using the Actor Fitting Panel ......................... 29
- Setting Character Poses .................................. 32
- Using Actor Project File ................................ 33

## Scene
- What is a Scene? ............................................. 34
- Building a Custom Scene .................................. 35
- Adjusting the Z Values with 3D View ................. 36
CrazyTalk Animator is a revolutionary animation suite with all the necessary tools to easily create pro-level animation. CrazyTalk Animator’s stage is a 3D-layered 2D studio where you can drag and drop actors, props, scenarios, images and videos directly onto the setup stage. Create actors from any photo or illustration using CrazyTalk Animator’s innovative Actor Creator wizard. Bring actors to life with automatic facial animation & innovative puppeteering motions. Drag & drop to build sets with scenery and props. Film and direct all the action with camera & timeline tracks for complete 2D animation.
Knowing the Environment

Drag and Drop

CrazyTalk Animator provides several drag and drop methods to accelerate the building of your scene.

Adding Objects

Adding objects including: characters, props, image layers, effects, texts and backgrounds, can all be done by drag-and-dropping from different sources.

A. From the Content Manager Library
B. From Source Folder
The supported file types:
- Image: BMP, JPEG, TGA, PNG, GIF, SWF.
- Video: AVI, WMV, RM, MP4, MPG, FLV.
- Others (Transparent Videos): WMVJ, popVideo.

Dragging for applying

Character in Composer Mode

When you select a character and switch to the Character Composer mode, then you can drag and drop any props onto any body parts. CrazyTalk Animator will automatically attach the prop to the body part.

- Drag and drop a prop onto the character.
- The prop instantly attaches to the body part.

Assets Collection

You can drag and drop one or more assets, from the Content Manager, into your desired folder to create your custom library collection.

- Drag and drop assets from CrazyTalk Animator to a folder.
- Build a custom library collection.

- Drag and drop a motion template onto the character.
**Taking 2D Animation to the Next Level**

**Sprite Concept**

- **What is a Sprite?**
  
  A **Sprite** can be best understood as a group that consists of lots different media files. Though it can have multiple elements, it only shows one of them at a time. Sort of like a slide show.

  The elements of a sprite can be media files with different formats:
  - **Reallusion Specific Format**: *.iWidget, *.popVideo

- **Preparing a Custom Sprite**
  
  You can load different types of media, videos or images to create a sprite. When a sprite contains a series of image or videos, then you may create Image Replacement Animations in Stage mode with setting keys.

  **Loading Media to Form a New Sprite**

  **I Prop**
  
  1. In Stage Mode, click the **Import Media** button on the left-side tool bar.
  2. Click the **Props** button in the **Import Media** panel. Load multiple media files.
  
  A sprite with multiple media files will be created afterward.

  **II. Using the Sprite Editor**

  A. **Character**
  
  1. Select an existing character.
  2. Click the **Character Composer** button on the left-side tool bar.
  3. Select a body part (sprite).
  4. Click the **Sprite Editor** button at the left-side tool bar. The **Sprite Editor** panel shows.
  5. Click the **Insert** button. Load one or more media files.
  6. This body part is now a sprite with multiple media files. All the media files are now listed in the panel.

  **B. Prop**
  
  1. Select an existing prop.
  2. Click the **Prop Composer** button at the left-side tool bar.
  3. Click the **Sprite Editor** button at the left-side tool bar. The **Sprite Editor** panel shows.

  **Two More Methods to Create a Sprite or to Add More Media to a Sprite**

  If you want to create a sprite, or append more media onto an existing sprite, then you may use the two methods below:
  - **Sprite Editor** in actor or prop composer mode.
  - Drag and Drop from media source folders.
If you want to change the texture of any element in a sprite, then you need to enter the Composer Mode. In the Composer Mode, you may use the Color Editor tool to perform basic modifications to the elements, or you may use an external image editor for advanced modifications. The Color Editor may help you with editing Vector-based and Image-based elements. But take note that the External Image Editor is more suitable for editing Image-based elements.

**Modifying the Textures of the Sprite Elements**

If you want to change the texture of any element in a sprite, then you need to enter the Composer Mode.

In the Composer Mode, you may use the Color Editor tool to perform basic modifications to the elements, or you may use an external image editor for advanced modifications.

The Color Editor may help you with editing Vector-based and Image-based elements. But take note that the External Image Editor is more suitable for editing Image-based elements.

**Editing Vector-based and Image-based Elements**

**A. Basic Usage - Editing Single Sprite**

1. Select a character, and then enter the Composer Mode by clicking the Character Composer button.

2. Select one of the body parts and then click the Sprite Editor button.

3. Select Skin in the Choose Group drop-down list.

4. Modify the Brightness, Contrast, Hue, and Saturation value. You can see that only the face skin is modified.

5. If you activate the Affect All box, then the character's entire skin color will be modified.

**B. Advanced Usage - Affecting All Sprite**

The Color Editor provides features for you to modify the character's skin, hair, clothes, and others as a group. This way you do not need to modify them individually.

1. Select a character, and then enter the Composer Mode by clicking the Character Composer button.

2. Select the face and then click the Color Editor button.

3. Select Skin in the Choose Group drop-down list.

4. Modify the Brightness, Contrast, Hue, and Saturation value. You can see that only the face skin is modified.

5. If you activate the Affect All box, then the character's entire skin color will be modified.

**Editing Image-based Elements**

If you want to use an external image editor to modify an image-based element, then follow the steps below:

1. Select a character in the Stage Mode. Click the Character Composer button to switch to the composer mode.

2. Select one of the body parts and then click the Sprite Editor button.
3. Pick the element in the list for editing.

4. Click the Launch button.

5. CrazyTalk Animator will then launch your specified image editor (e.g., Photoshop) with the texture opened in it ready for advanced modifications.

6. Edit the image and save. The data will then be automatically transferred into CrazyTalk Animator.

7. Click the Back to Stage button to update the character in the Stage Mode.

---

**Project Settings**

In the Project Setting panel you may adjust the length of the project, the time unit shown on the time counter, the viewing method of the camera and the background.

Click the Project Setting button to open the Time Setting panel.

**Time Setting Section**

- **Animation Length**: Shows the total length of the project in frame count. The default length for each project is 900 frames. The maximum frame number is 27000.
- **Select Time Unit**: You may decide to display the time unit in either frame format or time format.

---

**Camera Setting**

The camera setting decides the viewing method of the camera.

- **Perspective** (Keyboard Shortcut: O): This method shows the Z-depth relation of each item inside. The size of the objects, in theory, alter automatically in accordance to the distance of the item.

- **Orthographic** (Keyboard Shortcut: O): This method shows the project regardless of the Z-depth of each object inside. This method is used by most image editing software since Z-depth is unnecessary for them. Therefore, the size of each object looks the same even if it is far away from the camera.

- When the camera moves, the closer objects move faster while the farther ones move slower.

**Background Setting**

In this section, you may set the background of your project to a solid color or a prepared image.

- **Click the ColorPicker** to select a solid color as the background of the current project.
- **Activate the Active image** box and then click the button to load any prepared image as the background.
- Select from the Display Mode drop-down list to define the mapping method for the image background.
CrazyTalk Animator

**Video - External Files**

By default, CrazyTalk Animator compacts all loaded video files into a project file, which increases the total size of the project.

To prevent this, you may click on the **External Files** button to have all the video files saved as external files. This can solve the over-sized project issue. However, do remember to move all the video files together, along with the project file, if you move the project to another folder destination.

**Defining Your Own Actor**

**Mix-matching Composite Characters from the Library**

**Creating a Character from the Library**

1. Go to **Actor >> Character**. The Content Manager will then switch to the character library.
2. In the **Template** tab, double click on (or drag and drop) one of the templates to apply.
3. Select the character if it is not selected.
4. Change the **Content Manager** to **Actor >> Head library**
5. Apply different head templates from the **Template** or **Custom** libraries found in the **Content Manager**.
6. Change to **Actor >> Body library**
7. Apply different body templates from the **Template** or **Custom** libraries found in the **Content Manager**.

**Head Types in CrazyTalk Animator**

There are three types of heads in CrazyTalk Animator. You can create them by loading and fitting with an image, composing with various feature parts, or mix up these two types of head.

<table>
<thead>
<tr>
<th>Morph-based head</th>
<th>This type of head is created by the Face Creator. The eyeballs and teeth are inside of the head like a real person. You can also modify this kind of head by the Face Creator in the Character Composer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sprite-based head</td>
<td>This type of head is created by the Character Composer. Each facial feature is pasted onto a face to compose a head. If you want to modify this kind of head, then you need to use the Character Composer.</td>
</tr>
<tr>
<td>Hybrid head</td>
<td>You can mix up the two kinds of head to generate special character by both creating methods above, as well as modification. The facial features from the Face Creator and from the libraries in the Character Composer &gt;&gt; Head can be puppeteered or set facial keys simultaneously. Please switch to the <strong>Actor &gt;&gt; Head</strong>, and apply hybrid head from the <strong>Head &gt;&gt; Human &gt;&gt; Hybrid</strong> library.</td>
</tr>
</tbody>
</table>

**Customizing Your Actor With Character Composer**

**Changing Parts of a Character**

In the Mix-matching Composite Character from Library section, you can perform basic character compositions by changing the head and the body from the **Content Manager**. You may use the advanced method to compose a character with the **Composer** features.

**Composing a Character**

1. First select a character.
2. Click the **Character Composer** button to switch to the **Composer Mode**.
3. Click the **Head >> Head** button on the top panel. Apply a head template from the **Content or Custom** libraries.
4. To change to the corresponding libraries, simply click the **Body** button on the top panel and then click the sub-buttons that belong to the body.
1. Apply templates from any of the libraries found. (Upper to Tail)

2. Apply desired template from the Face and Hair libraries. Please note that there is no specific order to applying the facial features. However, it is highly recommended that you first apply the Face before the others.

3. Apply Face

4. Apply Brow and Eye

5. Apply Nose

6. Apply Mouth

7. Apply Ear

8. Apply Hair

Changing the Layer Order - Body Parts and Facial Features

In CrazyTalk Animator, each character is composed of body parts and facial features (sprites). Therefore, there is a certain layer order for them. You may change the order manually with the Character Composer, so that when the character scratches its head, the hand will be behind the head instead of being in the front of it. You may also use this method to stylize faces and hairdos.

Changing the Layer Order

Please follow the below steps to reorder the layer of a body part and/or facial feature:

1. Select a character.

2. Click the Character Composer button. Please note that the character will return to its initial pose inside the Composer Mode.

3. Rotate a body part to check the order.
There are two methods for you to create a head (face) from an image. Once a head is fully created in CrazyTalk Animator, then the converted image character will be able to talk with expressions. Please note that only image characters whose heads have been fully created will be able to have expressions on their face.

Image Processing

The image processing tools allow you to enhance the quality of selected images. You may rotate and crop them in order to work with a portion of the original image source. This allows you to focus on facial details in order to create more accurate talking characters.

Automatic Image Fitting

The 4-point auto fitting for the basic anchor points allows you to create a CrazyTalk Animator model in just a few clicks. This process is entirely automatic and requires no complex frame fitting techniques. Once you create a basic frame to fit the face, then you can use the fitting tools to increase the definition of the wire frame by simply adjusting the additional frame points.

CrazyTalk Animator has its own embedded estimation of the four points which define the eye and mouth areas. If you wish to move the positions, then you may click and move the numbered indicators 1, 2, 3 and 4, on the image. Do this to adjust the fitting process as displayed in the reference image.

Click the Reset button at any time to cancel your actions and start over.
Face Fitting

In the Face Fitting page you may detail the wire-frames and control points of the face, set the side face style, modify the background mask, and apply virtual eyes and mouth.

Facial Wireframe Modes and Replacing Face Images

On the left-side tool bar, the Fitting Mode is pressed as the default button. This helps you fit the feature points to all appropriate locations.

If you wish to change the face image without affecting or re-arranging the wireframes or facial points, then you use the Replace Image feature.

Preview Mode

In the Preview Mode you may review facial fittings, eyes, mouth and background mask results.

Basic Facial Mode and Detailed Facial Mode

You may click the Basic Facial Mode or Detailed Facial Mode button to view the wire frame around your character. You may also drag the control points, or lines, to fit a character's face more precisely.

- Click the Select button to pick and move components of the wire frame.
- Click the Rotate button to rotate the wire frame or the frame component (wire).
- Click the Scale button to adjust the size of the wire frame.

Specifying Face Orientation and Style

Click the Face Orientation button to adjust the profile style. Then define the orientation of the character:

- Click the Open/Close Mouth Points button to open or close the mouth points of the wire frame. This will cause the points of the upper and lower lip to move together as a single line. If your model has a closed mouth, then we suggest you to use this option. This option is available only when you select the Detailed Facial Mode.
- Click the Calibration button to play back a short script intended for calibration. Click the down arrow next to it if you wish to select a specific part of the face.
Selecting Appropriate Face Style
1. Select one of the 9 basic profiles to fit your character.
2. Drag the Strength slider to adjust the intensity of the profile. The higher the value, the more accentuated the profile and motion of the character will be.
3. Press the Preview button and move your mouse to preview the head motion in the main viewport. If the motion is not as desired, then re-adjust the Strength value or try another profile style.

● Editing the Background Mask

The background mask hides all unnecessary areas of the loaded photo. This helps you only the areas you are interested in, such as the character’s head or body.

There are two methods to generate a background mask for your image:
● Utilizing Background Mask Editing panel.
● Utilizing external image editor before the image is loaded.

Using Background Mask Editing Panel

● Click the Full button and then click on the image to fill with the mask color. You may adjust the Tolerance slider to increase or decrease the background mask over the image target area.

● Click the clear button to delete the background mask.
● Click the Inverse button to invert the background mask area. The area that was previously defined as the background mask will now be inverted with the non-masked area.
● Use the Brush Tools to specify whether you want to increase or decrease the background area.
● Click the Paint button (Shortcut: P) if you want to enlarge the background area or simply add more parts to it. Click the Erase button (Shortcut: E) to erase parts of the background mask.
● Adjust the Brush Size slider to increase or decrease the size of the brush tool. Use a thinner brush size when you want to adjust small areas of the background mask. Alternatively, enter a number in the box next to the slider to specify the brush size.
● Click Mask Color to specify the color of the background mask from the color palette. The mask color does not actually show up on the model; it is for your reference only.
● Move the Opacity slider to specify the opacity of the background mask. The mask opacity does not actually show up on the model; it is for your reference only.
● Move the Contract/Expand slider to contract or expand the background mask.
● Move the Edge Feather slider to blur the background mask.
● Click the Preview button to review results.

Loading an Image with a Predefined Alpha Channel

If you wish to perfect your image mask, then you may pre-save your image with a pre-defined alpha channel. This can be done by means of an external image editor. Once you create your mask outside, simply load the image into CrazyTalk Animator. The alpha channel information will automatically be applied as the background mask in the Background Mask Editing panel.

Notes:
- The alpha channel information can be in 32-bit BMP, TGA or PNG format.
- If you wish to save the source image as PNG file, then remove the background layer, erase any unnecessary area of the image and save. You do not need to create an alpha channel layer in the Channels panel.
CrazyTalk Animator introduces VividEye Technology in a layer-based concept. The six Layers (Eyeball - Iris, Eyeball - White, Eye Light, Eye Shadow, Eyelash and Makeup) in the VividEye Settings greatly increase the realism of virtual eyes. Original eyes from the source image cannot roll, so it is important to add virtual eyes to the animation.

Click the Eye Setting button at the left-side tool bar to access the VividEye Technology.

VividEye Technology

The six layers superimpose to create the appearance of natural eyes:

- **Eyeball Transform**
  - After applying a virtual eye template, switch to the Modify tab to use the advanced adjustments below:
  1. Switch to the Modify tab.
  2. Select the Right or Left eyeball from the drop-down list.
  3. Choose the Eyeball - Iris or Eyeball - White radio button.
  4. In the Transform section, adjust the Scale value to decide the size of the eyeball.

- **Eyeball Iris Color and Eyeball Whites**
  - You may customize the color of the eyeball by changing the diffuse color of the iris and adjusting the whiteness.
  1. Please make sure the head has virtual eyes applied.
  2. Select the Right or Left eyeball from the drop-down list.
  3. Choose the Eyeball - Iris or Eyeball - White radio button.
  4. In the Color section, adjust the values for Brightness, Contrast, Hue and Saturation.

- **Eye Light**
  - The Eye Light simulates the specular effect on the eyeballs, which implies the light direction. This feature facilitates you in creating sparkling, crystalline, or turbid eyeballs.
  - You can also use custom light shapes by loading a grayscale image into the Opacity channel.

- **Design the Light Shape**
  - There are three sections in the modify page involved in the designing of light shapes: the Opacity channel, the Transform, and the Opacity/Blur sections.
  1. You must apply an eye template from the eye gallery first.
  2. Select the Right or Left eyeball from the drop-down list.
  3. Choose the Eye Light radio button.
The **Eye Shadow** feature allows you to adjust the size and color of the shadow, as well as the opacity and blurriness of the shadow.

- **Set the Sphere Sense of the Eyeball**
  - If you need to set the sphere-feeling of the eyeball, you can adjust the **Opacity channel** to increase or decrease the sensation.
  - Select the **Right** or **Left** eyeball from the drop-down list.
  - Choose the **Eye Shadow** radio button.
  - Select the **Opacity** icon. Set the values in the **Opacity/Blur** section.

**Eyelash**

**CrazyTalk Animator** offers **Eyelash** effects to generate a more vivid appearance in the eyes. You may apply the **Eyelash** effect to mimic mascara, and enhance the eyelashes of the model.

- **Heavy shadow (spherical eyeball)**
- **No shadow (flat eyeball)**

**Makeup**

**CrazyTalk Animator** offers **Makeup** effects to generate vivid eyes. With the **Makeup** feature, you can apply various make-up styles such as Smokey, golden shimmering or bruised eyes. You can also use it to conceal or cover creases or defects on the models' eyelids. Distortions and stretching issues created when models close their eyes can also be covered with **Makeup** effects.

- **Smokey eye**
- **Golden shimmering eye**
- **Bruised eye**

- **Face Fitting**

**Mouth Settings**

Every character in **CrazyTalk Animator** is able to talk. You may apply a virtual mouth with teeth, along with modifying the mouth color and lips settings on the character.

- **Applying Mouth Template**
  - In the **Face Fitting** page, click the **Mouth Setting** button on the left-side tool bar.
  - Apply one of the templates from the **Template** library.
Taking 2D Animation to the Next Level

After you apply a virtual mouth, you may then modify the location, orientation and the color of the teeth inside the mouth.

**Teeth Location and Angle**
1. To set the size of the teeth, use the *Scale* feature. Adjust the X/Y values to adjust the width and height of the teeth.
2. To specify the position of the teeth in the mouth, use the *Move* parameters. Adjust the X/Y values to relocate the teeth.
3. Use the *Rotate* value to decide the orientation of the teeth and match the angle of the mouth.

**Teeth Color**
Use the *Color Settings* feature to choose the color of the teeth. Move the *Brightness*, *Contrast*, *Hue*, and *Saturation* sliders to adjust the tooth color. Alternatively, enter a number in the boxes next to the slider bar to change the parameter value.

**Throat**
*CrazyTalk Animator* lets you modify the inner mouth and throat color for when mouths need to be opened wide.
1. Choose the *Throat* radio button.
2. In the *Color* section, adjust the value of the *Brightness*, *Contrast*, *Hue* and *Saturation*.

**Lips**
Most of the time, characters in photos smile. However, the mouth shape may not be as natural as you might expect when characters talk in *CrazyTalk Animator*. This is because the height of the lip corners. You may use the lip settings to lower the lip corners and keep the mouth line as flat as possible.

After you apply a virtual mouth, you may modify the corners of the lips.
1. Choose the *Lips* radio button.
2. In the *Lips corner* section, adjust the position values of the *Left Corner* and *Right Corner*. 
3. Activate the **Force to Close** box to close the character's mouth. Check the **Force to Close** checkbox to close the model's lips. This feature is useful when the original image has an open mouth. Make sure that the control points for the open lips are correctly specified when adjusting the wireframe.

**Generating a Body from a Photo**

In **CrazyTalk Animator**, we use the sprite-to-bone method to dissect characters from the photo and break them down into individual body parts called sprites. Then we stick the sprites to virtual bones so that when the virtual bones are animated, the sprites are triggered to move.

**Image Processing**

The image processing tools allow you to enhance the quality of selected images. You may rotate and crop them in order to work with a portion of the original image source. This allows you to focus on facial details in order to create more accurate talking characters.

**Editing the Background Mask**

The background mask hides all unnecessary areas of the loaded photo. This helps you only the areas you are interested in, such as the character's head or body.

**Using the Actor Fitting Panel**

The **Actor Fitting** panel is divided into three modes to help you fit virtual bones to an image character. The modes are: **Simple Mode**, **Basic Mode**, and **Detail Mode**.

**Deciding the Pose**

Before you start fitting the body points, it is crucial to define the bone perspective as **Front** or **Side**. You must correctly define this by selecting one of the tabs on the top-right of this page.

**Match Shape Step**

Click the button to switch to the **Match Shape** process in order to align the numbered points to the main joints of the character.

- Original Image
- Force to Close: ON

- Original body image
- Masked body image

- Select Front Body tab
- Select Side Body tab

- Point 1 and 3: Both wrists.
- Point 2: Bottom of the Neck.
- Point 4: Pelvis.
- Point 5 and 6: Both ankles.
Taking 2D Animation to the Next Level

CrazyTalk Animator

**Rig Skeleton Step**

Click the button to switch to the Rig Skeleton step. Here you will see more points as shown in the preview window.

**Detail Body Step**

Click the button to switch to the Detail Body step. Here you may modify the body part by changing the properties of each point in order to get the best results.

**Capsulate the Body Parts**

You may capsulate all body parts so that the connective edges form into arc shapes.

1. Remember to increase the size of the circle around the control point in order to fit all parallel edges of the body part. This step splits the image into two adjacent body parts, each with arc-shaped connective edges.

2. Drag the capsule side points to frame up the full image of the body part.

3. Repeat the same steps to capsulate all the other body parts. This step will prevent breaks when the character performs motions.

4. Click the Process button to fine-tune the shape of the capsules.

5. Click the Mask Segment button. The mask-editing panel will show.

6. You may then use the brush to modify the mask inside, in order to change the shape of the capsule.

7. If the body part mask is refined while the image itself is covered, then switch to the Paint tab on the right top of the panel.

- Drag and align the control points to the appropriate positions in order to match the joints of the character.

- A control point breaks the image down into two connected body parts.

- The break occurs as the body part moves.

- Please note that the highlighted blue area, in the preview window, is locked. You cannot perform any modifications in this area.

- Please note that you may activate the Auto Detect box to automatically create the circle size around the joints. This will follow the body mask you defined in previous page.
8. Paint the image with the tools provided. Remember to often click the Preview button in order to preview the modification results in the main Preview Window.

9. Click the OK button to finish editing. Repeat the steps above to modify all the other capsulated body parts.

### Setting Character Poses

Sometimes a character's pose, in the source photo, can be different. For this, you need to set the correct pose inside CrazyTalk Animator so that motions are created with satisfying results.

#### The Concepts of Poses

**CrazyTalk Animator** can handle two types of poses during character fitting:

- **Original Pose**
  - This basically fits all poses. You may use this pose by making minor adjustments to the body. This type of pose has less occlusion of body parts, which gives better flexibility during animation.

- **Fitting Pose**
  - This pose ensures the best fitting results for animation. It is highly recommended to apply this pose of an upright standing body, complete with clear arms and legs. It features:
    - Legs: 45 degrees with clear information for shoes (side, opposite side of shoes for both sides).
    - Arms: relaxed and opened, do not raise shoulders, full upper arms and forearms display, slight angle for joint reference.

In the final step of **Actor Creator**, you may decide to keep the **Original Pose**, or force the character to have a **Default Pose**.

- **Default Pose**
  - This pose is the built-in pose inside CrazyTalk Animator. With this pose, all motion results will be guaranteed.

### Setting Pose

Since character poses in photos may vary, CrazyTalk Animator provides features for you to keep the **Original Pose**, or to force the character to strike a **Default Pose**.

1. Prepare a photo.

2. Follow the procedure described in the Generating a Body from a Photo section, to the last page of the **Actor Creator**.

3. If you want the character to keep the pose of the original photo, then click the **Original Pose** button.

4. If you want to force the character to strike a default pose, then click the **Default Pose Reset** button.

5. You will see the different poses of the character in the working area.

### Using Actor Project File

An actor project file is a file packed with the character's image, mask information for each body part and detailed body control point data.

#### Generating an Actor Project File

1. Use the **Actor Creator** wizard by clicking the **Actor Creator** button in Stage Mode.

2. Follow the instructions of the wizard.

3. Click the **Save** button to save the character-related data as an actor project file (*ctAfData).

#### Reusing an Actor Project File

If you would like to modify the results of the created character, then you may use the saved actor project file to further modify its mask segments and control points.
Taking 2D Animation to the Next Level

1. Click the Actor Creator button on Stage Mode.
2. Click the Open Actor Project button. Load the saved project file.
3. The Actor Creator wizard will pop up. You may now further modify the character.

Scene

What is a Scene?
In a CrazyTalk Animator project, you can apply one and only one scene, which is made of a group of props. You may then store all well-organized props and background into a single scene file. This saves a lot of time by adding and applying them back when you need them.

Building a Custom Scene
CrazyTalk Animator is an image-based animation tool. Every prop inside is made of one or more images. You may use various props to build up a CrazyTalk Animator scene.

Building a Scene
1. In Stage Mode, click the Import Media button and select a prop in the panel.
2. Load a media file and convert it into a new Prop.
3. The newly-added props are all under the Prop item in the Scene Manager.
4. Right-click on the prop you want to add to the scene. In the right-click menu, select the Add to Scene feature.
5. Look at the Scene Manager, you may see that the prop is now moved under the Scene item.

Extract Props from a Scene
After you apply a scene template from the library, then you may extract the props within the scene. The props will not be replaced during the next scene replacement.

1. Apply a scene template from the library.
2. In the scene manager, you may see all the props within the new scene.
3. Select the desired prop and right-click on it.

A scene with props
A scene in the 3D view
A scene with props and static background
A scene in the 3D view

The characteristics of a Scene template:
- A scene template is able to include props and background.
- Scenes are exclusive to each other.
- You are allowed to build a custom scene by adding more props into the scene.
- Props in a scene can be extracted.
- If a scene must be used in a different time of day (day, night), then do not apply a background before producing a custom scene template.
4. Choose the **Convert to Prop** command. The prop will be moved under.

5. Apply another scene template. This prop will not be replaced while all the other props under the Scene will be replaced.

### Using Media with Masks

It is highly recommended for you to load media with masks (alpha channel) so that the when the media files are loaded into CrazyTalk Animator then the unnecessary parts are filtered out. The supported file formats (with masks) are *.png, *.tga (32 bits), *.bmp (32 bits), *.gif, *.popVideo and *.iWidget.

In CrazyTalk Animator, each prop can be composed of at least one sprite. In another words, a prop is usually a group of at least one sprite.

The individual sprite, that forms the prop, can have more than just one element. The format of the element can be of a image or video.

The structure concept is described in the following illustrations:

- **Without Mask**
- **With Mask**

### Adjusting the Z Values with 3D View

Even though CrazyTalk Animator is a 2D-based application, it still contains a Z-depth system. Each character and prop possesses its own Z-depth layer that determines the distance of it from the center of the project.

#### Using 3D View to change the Depth

1. Add characters and props to the working area.
2. Select a character or a prop.
3. Click the **3D View** button to switch the camera to the 3D top view.

- Drag with the right-mouse button to change the angle of the camera.
- Drag with the left-mouse button to pan the camera.

4. Drag the blue arrow to change the Z-depth of the selected item.

#### Using the Mouse Wheel to change the Depth

1. Select a character or prop.
2. Roll the mouse wheel and you will notice that the Z-depth will start to change.

- Roll the wheel UP to increase the Z value.
- Roll the wheel DOWN to decrease the Z value.

### Prop

#### What’s a Prop?

In CrazyTalk Animator, each prop can be composed of at least one sprite. In another words, a prop is usually a group of at least one sprite.

The individual sprite, that forms the prop, can have more than just one element. The format of the element can be of a image or video.

The structure concept is described in the following illustrations:

- A prop with a sprite containing a single media file.
- A prop with multiple sprites. Each sprite contains one or more media files.

Here is another example with item structures:
Taking 2D Animation to the Next Level

Creating Composite Props with the Prop Composer
After creating props in the Stage Mode, you may use the Composer to make props contain other sprites.

Creating a forest with a single tree
1. Apply a tree prop and select it in the Stage Mode.
2. Switch to the Composer Mode by clicking the Prop Composer button.
3. In the Composer Mode, look inside the Scene Manager and you will notice that the prop only contains one sprite.
4. **DO NOT** select the prop. Just apply the same tree prop over and over again from the library.
5. Click the Back to Stage button and select Yes to update the prop.
6. You have now created a Forest with one single prop.

Modifying Sprite Transformations of a Prop
Inside the Composer mode, you may adjust the position, the orientation and the size of each prop sprite. This may alter the appearance of the prop. With this feature, different props with identical sprites inside, may look different due to the modifications of the transform data.

1. In the Stage mode, select a composed prop with compound sprites.
2. Click the Prop Composer button.
3. Pick one of the sprites that belong to the prop.
4. Move, scale or rotate the sprite.
5. Repeat the steps to transform one or more sprites inside.
6. Edit the texture for each sprite. Please refer to the Modifying the Textures of the Sprite Elements section for more information.

Click the Back to Stage button to update the prop.

Using the Attach Feature
After you create composite props with the prop composer, the components, also named sprites, are all at the same level under the root node. However, you may need to group some sprites together to have them animate at the same time. Use the Attach feature to group them.

1. In the Stage Mode, select a compound prop created earlier.
2. Click the Prop Composer button.
3. Switch from the Scene Manager to the Scene tab.

The sprites are all under the root node.

4. Select a sprite which is a child of another one.
5. Click the Attach button and pick another sprite which you want as a parent.
Taking 2D Animation to the Next Level

6. The sprite will then be moved under the new parent.
7. If you transform the parent, then the child will be affected as well.

Note:
The Attach feature can only be done in the Composer Mode.

Locating the Center
The center (also called “Pivot”) of a character or a prop decides the base for position, rotation and proportion change in the Stage mode. You may use the Composer to locate the center of any character or prop.

1. In Stage Mode, select a prop. You will notice that the center of the prop is inside a circle.
2. Click the Prop Composer button.
3. Select the root sprite of the prop in the Composer Mode. (The root sprite can be found in the Scene Manager >> Scene.) Turn on the world axis by using the hotkey: Ctrl + A.
4. Drag the sprite away from the world center (where the axis coordination is).
5. Click the Back to Stage button.
6. The center of the prop is now different. You may rotate or scale the character or prop, to see the difference.

Special Effect

Using Text
If you wish to display comic text when the character is talking, then simply use the text embedded inside CrazyTalk Animator.

1. Load or create a project.
2. In the Stage Mode, switch to Special FX > Text.
3. Apply one of the templates to your project.
4. Double-click on the text (or click the Text Editor button) and modify the text inside.
5. The modified text will now appear in the stage.
Taking 2D Animation to the Next Level

**Using Special Effects**

If you wish to apply special effects to your scene, then you may use the special effects embedded in CrazyTalk Animator.

1. Prepare a project which you wish to add special effects to.
2. In Stage Mode, switch to Special FX >> Object.
3. Apply one of the templates to your project.
4. Move, scale or rotate the object to where you need it.

**Animations**

**Animation Concepts**

**Creating a Path Animation**

Once you create a character or a prop, you may then create a path for it. When you playback the project, the character or prop will then move along the path you set.

**Creating a Transform Path**

1. Select a character or a prop (character in this example) in the Stage Mode. By default, CrazyTalk Animator switches to the Transform mode as soon as you select a character or a prop.
2. Go to another time frame.
3. Set a key by transforming inside the working area. A green path automatically forms.
4. If you want to set a key on the Z axis, then you may do so by adjusting the Z values with 3D view.

**Editing the Path Shape**

Once the path is created, you may need to edit it.

1. Go to another time frame. Move, scale or rotate the prop away in order to generate a new transform key.
2. Repeat Step 1 to add more points to the path.
3. Drag a point on the path, but away from its current location. The line between the two key points will be automatically modified.

4. Click the Transform button on the tool bar above the working area.
5. Switch between the Curve and Line buttons to change the path from a curve to a straight line.

**Sprite Animation**

**Sprite Transformation Animations**

Since props are usually composed of a group of at least one sprite, you may imagine a prop as a container that contains one or more sprites. The container will perform its own animations while the sprites inside of it perform their own individual animations.

Please note that this feature only supports props and not characters.

1. Select a prop (with one or more sprites) in the Stage Mode.
2. Click the Prop Key Editor button on the left-side tool bar. The Prop Key Editor panel will appear.
3. Select the target sprite in the prop.
4. Move, rotate or scale the sprite to set a transform key.

• How to rotate a sprite around? Use three keys to make a sprite turn around: 0→179→359 instead of 0→180→359.
5. Go to another time frame and add a new transform key.
6. Repeat Steps 3 to 5, to create a transform animation for another sprite in the same prop.
7. You may also set a path for the prop to move along. Please refer to the Creating a Path Animation section for more information.

Sprite Switch Animations

Once you have a sprite that consists of multiple media, then you may use it to create sprite switching animations. By selecting one of the sprite’s media in different time frames, the sprite shows different appearances when played back.

Take note that this feature supports both characters and props.

1. Creating Sprite Switch Animations
   1. In Stage Mode, click to select a character or a prop.
   2. Click the [Sprite Editor] button.
   3. Go to another time frame.
   4. Pick one of the media files in the Sprite Editor panel. A switch key is automatically set. Please note that in this example, the picked element is an animation.
   5. Play back the project. When it comes to the frame where the key is set, the picked file from the last step will show.

Making a Turn by Flipping Side

When you create a back and forth motion path for a character or a prop, you may need it to face the other side at a certain point so that it does not seem to be moving backwards. This is especially useful if you want to make vehicles or strolling pedestrians approach the scene from a distant perspective.

1. Select a character or a prop that moves from left to right and left again along a path.
2. Once the prop reaches the middle point of the path, it will be necessary to flip the prop’s facing side.
3. Drag the play head to the time frame where the character or the prop’s side is supposed to turn.
4. Click the [Flip] button on the toolbar above the working area. The prop will then be flipped for the rest of the path unless you flip it again.
5. By default, characters and props flip horizontally. You may drag down the list and click the triangle to set flip to horizontal or vertical.

Using the Mouse Cursor in the Motion Key Editor and Puppet Editor

You may use the Motion Key Editor and Puppet Editor to produce a character’s facial expressions and body motions. However, when these panels show, there are specific reaction areas for your mouse movements to take effect. The mouse movements can be categorized into two aspects: Cross Movements and Circular Movements.
**Taking 2D Animation to the Next Level**

When you use the **Body Puppeteering Panel** to preview or record body motions, then you use a circular mouse movement to control.

*Please notice:* You must drag a circular movement around the **Tmark** inside the working area. The motion speed is determined by how fast you draw the circle.

- If you drag the mouse in clockwise direction, then the character motion performs forward.
- If you drag the mouse in counterclockwise direction, then the character motion performs backwards.

**Partial Circular Movements**

You do not need to always make a full circle around the mark to produce a complete motion. You can move back and forth in an arc movement to puppet the character in a partial movement of the preset motion.

**Character Animations - Face Animation**

- **Five Approaches to Generating Facial Expressions**
  - There are five main methods to generating facial expressions for a character.
  - **Facial Expressions from the Library**
    - The easiest way to apply character expressions is by choosing templates from the **Content Manager**. To do this, simply click the **Animation** tab on the top panel.
  - **Templates Containing Facial Expressions**
    - You may apply facial expressions, from several types of motion templates, found in the library list below:
      - **Face**
      - **Perform**
      - **Action Menu**
    1. Select a character.
    2. Double-click on the desired template (or drag and drop the template onto the character) from the **Face** or **Perform** library.
    3. The character will then proceed to act out the expression.

- **Using the Sprite Editor to Switch Facial Expressions**
  - The facial features of a **Sprite-based** head are actually sprites with one or more elements inside.
  - By using the **Sprite Editor**, you may switch to any element in a facial feature. Elements compose various expressions on the character's face.
  1. Select a character with a **Sprite-based** head.
  2. Go to different time frame.
  3. Click the **Sprite Editor** button.
Taking 2D Animation to the Next Level

CrazyTalk Animator combines facial animation with revolutionary, real-time puppeteering controls to empower users with easy-to-use facial expressions commands.

Full Face Control Puppeteering

The Full Face control Puppeteering uses presets for puppeteering and recording expressions. If you are using a Hybrid Head, then it is highly recommended that you use the Solo Feature Selection Puppeteering method to create facial expressions.

1. Select a character and click the "Puppet Editor" button.

2. If the Body Puppeteering Panel shows, then click the "Switch to Face Puppet" button.

3. Pick a desired profile from the Face Animation Profile list.

4. Choose a preset in the Full Face Control list.

5. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar.) The cursor will automatically be positioned in the center of the CrazyTalk Animator window (the mouse interactive area covers the entire CrazyTalk Animator interface).

6. Move your mouse to puppet. The selected face will be triggered to move with the mouse cursor. Press the Space bar again to stop previewing.

7. Click the "Record" button and press the Space bar (or press the Alt + Space Bar) to start recording the motion as puppeteered by your mouse. (Press the Enter key to start the half-speed recording mode)

8. Once the recording stops, a clip with all the recorded expressions will be stored in the Facial Clip Track of the character.

Note:

Click the "Play" button on the play bar to view the puppeteering recording results.
1 Solo Feature Selection Puppeteering

When you do not wish to use puppeteering presets, and you wish to record the expressions of a single facial feature, then you can use the Solo Feature Selection pane for puppeteering.

1. Select a character and click the Puppet Editor button.
2. If the Body Puppeteering Panel shows, then click the Switch to Face Puppet button.
3. Click the Clear Selection button. All the selected features will be deselected.
4. Pick the desired facial features from the Solo Feature Selection pane.
5. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar.) The cursor will automatically be positioned in the center of the CrazyTalk Animator window (the mouse interactive area covers the entire CrazyTalk Animator.)
6. Move your mouse in order to puppet. The selected face will be triggered to move with the mouse cursor. Press the Space bar again to stop previewing.
7. Click the Record button and press the Space bar (Or press the Alt + Space bar) to start recording the motion as puppeteered by your mouse. (Press the Enter key to start the half-speed recording mode)
8. Once the recording stops, a clip with all the recorded expressions will be stored in the Facial Clip Track of the character.

1 Multi-Layer Recording

When you follow the instructions in the Solo Feature Selection Puppeteering section, then you are generating a facial clip expression at one time. However, you may also apply the multi-layer recording method to record the feature motions individually.

1. Launch the Facial Puppet panel.
2. Go to a time frame when you want the puppeteering to start.
3. Select one feature and record the puppeteering result as a clip.
4. Go to the time frame specified in step 2.
5. Click the Clear Selection button and select another facial feature in the pane.
6. Start to puppet and record the motion of this selected facial feature.
7. When you stop recording, the motion of the selected feature will be layered into the facial clip.
8. Repeat Steps 3 to 6 until you are satisfied with the model’s expression results. Each recording will blend, layer by layer, the effects to the motion clip.
Using the Face Key Editor
CrazyTalk Animator integrates various key-editing panels into one single Face Key Editor. Use it to add/modify keys for Face, Head, and Eyes tracks.

1. Setting the Head Keys
Using the Face Key Editor, you can also set or modify the rotation/tilt keys of the character head.

- Including the Rotation Status into a Key
1. Select the Head Orientation button in the pane.
2. If you are using the mouse as your input device, then press and hold the left-mouse button inside the facial feature pane.
3. Move the mouse around, and the model will rotate its head to match the mouse movement. A head key will automatically be set.

- Including the Rotation Status into a Key
1. Select the Head Tilting button in the pane.
2. If you are using the mouse as your input device, then press and hold the left-mouse button inside the facial feature pane.
3. Move the mouse left and right to tilt the model's head accordingly. A head key will automatically be set.

2. Setting the Face Keys
If you do not want to set an expression, one facial feature at a time; then it is recommended that you use templates. Especially for Sprite-based faces.

- Using the Facial Tab
1. Select the desired facial features to set keys in the pane.
2. If you are using the mouse as your input device, then press and hold the left-mouse button inside the interactive area.
3. Drag the mouse in the interactive area to make the changes.

- Using the Template Tab
1. Switch to the Template tab.
2. Select a category from the Expression Style drop-down list.
3. If you are using the Sprite-Based face, then you may also select the For Comic category.

4. In the Template Library pane, click on the desired template.
5. Change the Expressiveness values to adjust the strength of the applied expression.

- Using the Modify Tab
If you use the Facial tab to set facial keys, then you are actually modifying the values of each slider in the Modify tab. Therefore, you can use the sliders inside of this tab to fine-tune the values for each facial feature.

1. Switch to the Modify tab.
2. Drag the slider to change the value, the selected character will then change the facial expression accordingly.
I Setting the Eye Keys
1. Select the Eyes in the pane.
2. If you are using the mouse as your input device, then press and hold the left-mouse button inside the interactive area.
3. Drag the mouse outside the interactive area to make the changes. The character's eyes will start to move along with your mouse. An eye key will automatically be set.

Utilizing the Action Menu for Expressions
CrazyTalk Animator provides a feature for you to embed expressions into any character. Just use the right-click menu to command the character to act any facial expression. The character can then be saved along with all the action commands.

I Using the Action Menu for Expressions
1. Select a character containing an action menu with facial expressions.
2. Click the Action Menu button. You will see a menu pop up.
3. Select any command that does not include; Add New Command or Delete All Action.
4. The character will then start the expression command.

Character Animation – Body Animation

Five Approaches to Generating Body Movements
There are five main methods to generating body movements for a character.

Body Movements from the Library
The easiest way to have a character move is to apply templates from the Content Manager. To do this, simply click the Animation tab on the top panel.

Templates Containing Body Motions
You may apply body motions from the templates found in the library list:
• Motion
• Perform
• Action Menu
1. Select a character.
2. Double-click on the desired template (or drag and drop the template onto the character) from the Motion or Perform library.
3. The character will then act out the animation.

Note:
How to distinguish between front or side motions:
• The front motion: Has an "F" on the bottom-left icon.
• The side motion: Has an "S" on the bottom-left icon.

Each template, in the Perform libraries, contains Motion and Face (voice and expression) data. Applying a template of this type will have the character perform and speak with expressions on its face.

Using the Sprite Editor to Switch Hand Gestures
The body parts of a character are actually sprites with one or more elements inside. By using the Sprite Editor, you may switch to any elements in a body part, which all together compose the look of the character. You may also use this method to switch hand gestures during different time frames.
1. Select a character whose hands contain more elements inside.
2. Go to a different time frame.
3. Click the Sprite Editor button.
Taking 2D Animation to the Next Level

Puppeteering - Character Transformation

In addition to the creating a path animation method, you may also use the Body Puppeteering Panel to create a character's transformation path.

1. Select a character.
2. Go to a specific time frame where you wish to start puppet the character's transformation data.

3. Click the Puppet Editor button to show the puppet panel. If it brings up the Face Puppet panel, then click the Switch to Body Animation button. The Body Puppeteering Panel will now show.

4. Press the Move button down.

5. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar).

6. Press Alt + Space bar to start recording, or click the Record button and press the Space bar to start recording the motion during puppeteering. The motion can be triggered with the same mouse manners as you did in the preview mode.

7. Press Space bar, or ESC key, to stop recording.

8. Go to the time frame in Step 2. Repeat the steps to puppet and record with the Zoom or Rotate buttons pressed. The illustration below shows the Zooming results.

9. If you have puppeteered the Move and Zoom data of the character, then you will see the Transform Path.

Using the Body Puppeteering Panel

1. Puppeteering - Character Transformation

   In addition to the creating a path animation method, you may also use the Body Puppeteering Panel to create a character's transformation path.

   1. Select a character.
   2. Go to a specific time frame where you wish to start to puppet the character's transformation data.
Taking 2D Animation to the Next Level

1. Puppeteering - Base Motion

You may have the character act some preset full-body motions from the library. This saves a lot of time when you need the character to do common motions found in daily life.

1. Select Base Motion from the Body Animation Profile drop-down list.
2. Select the Move, Idle, Talk and Mood icons.
3. Pick any one motion template from the category list.
4. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar)
5. The character will then perform the built-in motion of the template when you move your mouse in a circle.
   • A clockwise circle motion will cause the character to move forwards.
   • A counterclockwise circle motion will cause the character to move backwards.
   • The faster the mouse moves, the faster the character moves.
6. Press the Space bar again to stop previewing.
7. Press the Space bar to start recording, or click the Record button and press the Space bar to start recording the motion during puppeteering. The motion can be triggered with the same mouse manners as you did in the preview mode.
8. Press the Space bar or ESC key to stop recording.
9. Once the recording stops, a clip containing all the recorded motions will be stored as a single clip in the Motion Track of the character.

Note:
Use the front preset for front characters, and the side preset for side characters. Mix and matching presets may sometimes cause unexpected layer issues.
- The front motion: Has an "F" on the bottom-left icon.
- The side motion: Has an "S" on the bottom-left icon.

10. Press the Space bar or ESC key to stop recording.

1. Puppeteering - Body Parts

The Solo Body Part Puppeteering method helps you puppeteer specific body parts by mixing and creating a lot more motions than what the Base Motion category provides.

1. Select a character.
2. Go to a specific time frame where you want to start puppeteering the character's body movements.
3. When the Body Puppeteering Panel displays, select Body Parts from the Body Animation Profile drop-down list.
4. Select the Head, Leg, Arm or Torso icons.
5. Pick a motion template from the body part category list.
6. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar)
7. The character will perform the built-in motion template when you move your mouse in a circle.
   • Move your mouse in a clockwise motion for the character to move forward.
   • Move your mouse in a counterclockwise motion for the character to move backwards.
   • The speed of the motion is determined by the speed of the mouse motion.
8. Press the Space bar again to stop previewing.
9. Press the Space bar or ESC to start recording, or click the Record button and press the Space bar to start recording the motion during puppeteering. The motion can be triggered with the same mouse motions as the preview mode.
10. Press the Space bar or ESC key to stop recording.
Taking 2D Animation to the Next Level

Slider Control Mode

There are two methods to triggering motions within the Body Puppeteering Panel: Slider Control and Mouse Control.

- **Slider Control Mode**
  - Previewing Motion
  - Fine-tuning motion parameters and finding desired motion patterns.
  - Please note that recording during slider puppeteering is allowed.

1. Given a motionless character that moves from left to right, along a path.
2. In the Body Puppeteering Panel, select the Jump preset from the Base Motion category.
3. Switch to the Slider Control tab.
4. Start to preview (hotkey: Space bar) or record (hotkey: Alt + Space bar).
5. The character starts to perform the preset motion again and again. You may drag the Exaggeration or Speed sliders to affect the motion in real-time.
   - The Speed value decides the speed of the looping motion.
   - The Exaggeration value must be set before Previewing or Recording.

- **Mouse Control Mode**
  - The mouse movements trigger the motion of the character.
  - The circular direction triggers the motion forwards or backwards.
  - You do not always need to make a full circle around the mark in order to produce a complete motion. You can move back and forth in a simple arc motion to puppet the character to a partial preset motion.

6. Switch to the Preset tab. You will see parameter sliders for this preset.
7. Start to preview or record. The character will keep repeating the motion.
8. Drag the sliders during previewing or recording to change the motion weight of the body parts.

---

Slider Control and Mouse Control

There are two methods to triggering motions within the Body Puppeteering Panel: Slider Control and Mouse Control.

- **Slider Control Mode**
  - Previewing Motion
  - Fine-tuning motion parameters and finding desired motion patterns.
  - Please note that recording during slider puppeteering is allowed.

1. Given a motionless character that moves from left to right, along a path.
2. In the Body Puppeteering Panel, select the Jump preset from the Base Motion category.
3. Switch to the Slider Control tab.
4. Start to preview (hotkey: Space bar) or record (hotkey: Alt + Space bar).
5. The character starts to perform the preset motion again and again. You may drag the Exaggeration or Speed sliders to affect the motion in real-time.
   - The Speed value decides the speed of the looping motion.

- **Mouse Control Mode**
  - The mouse movements trigger the motion of the character.
  - The circular direction triggers the motion forwards or backwards.
  - You do not always need to make a full circle around the mark in order to produce a complete motion. You can move back and forth in a simple arc motion to puppet the character to a partial preset motion.

If you select the Jump preset from the Base Motion category, then the general result is as below.

- The Exaggeration value must be set before Previewing or Recording.
- Changing the Exaggeration value of may affect the motion weights during puppeteering.
Masking Puppeteering

Masking Puppeteering means to puppeteering individual body part by masking out the unwanted body parts of a Body Dummy, when you are using Full Body Puppeteering. You may extract a specific body part motion from the presets in the base motion.

1. Select one of the presets in the Base Motion.
2. Make sure that you have switched to the Mask tab in order to show the body dummy.
3. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar)
4. Deactivate the body parts of the Body Dummy in order to mask out the motions from these body parts.
5. Use the standard method to preview or record the character’s motion. Only the selected body parts will be puppeteered.

Multi-Layer Recording

Multi-layer Recording is about recording the character motions, layer by layer. It is helpful when you need to do the mix-recording. This way, the character can generate thousands of motion combinations from the limited number of templates. This method applies to both Full Body Puppeteering and Solo Body Part Puppeteering.

1. Follow the Masking Puppeteering procedure described earlier on this page, and record a motion of a specific body part.
2. Go to the time frame when the previous motion starts. Select another motion preset.
3. Pick other body parts on the Body Dummy.
4. Puppeteer and record the motions of the un-masked body parts.
5. Repeat to record motions of individual body parts (layer by layer). This way you may generate a whole new motion with your own puppeteering.

Using the Body Key Editor

CrazyTalk Animator integrates various key-editing panels into one single Body Key Editor. You may utilize it to add/modify transform keys to all the limbs on a character.

The Body Key Editor has two main functions:
- Producing key-by-key animations
- Modifying existing motion keys

1. Using Pose Mode - FK and IK

In the Pose mode, you may adjust the limbs with FK (Forward Kinematics) and IK (Inverse Kinematics) methods. You can do this in order to give a character a general pose, or you can slightly modify individual body parts in Body mode.

- Using FK and IK
  1. Select a character and click the Motion Key Editor button.
  2. Pick a Hand. You will see two concentric circles for use with the FK method.

- Using IK and FK
  1. Deactivate the body parts of the Body Dummy in order to mask out the motions from these body parts.
  2. Use the standard method to preview or record the character’s motion. Only the selected body parts will be puppeteered.

- Using FK and IK
  1. Select one of the presets in the Base Motion.
  2. Make sure that you have switched to the Mask tab in order to show the body dummy.
  3. Press the Space Bar to start previewing. (Or click the Preview button and press the Space bar)
  4. Deactivate the body parts of the Body Dummy in order to mask out the motions from these body parts.
  5. Use the standard method to preview or record the character’s motion. Only the selected body parts will be puppeteered.

- Using FK and IK
  1. Follow the Masking Puppeteering procedure described earlier on this page, and record a motion of a specific body part.
  2. Go to the time frame when the previous motion starts. Select another motion preset.
  3. Pick other body parts on the Body Dummy.

4. Puppeteer and record the motions of the un-masked body parts.
5. Repeat to record motions of individual body parts (layer by layer). This way you may generate a whole new motion with your own puppeteering.
3. Pick a **Leg**. Drag the cross arrow inside the circle in order to use the IK method to relocate the feet.

- If you want the joints of the legs to be in a correctly angled, then you need to drag the outer circle to form the angle first.

4. Pick the **Body**. Drag the cross arrow to move the pelvis of the character. This is easy when wanting the character bend his/her knees.

**Using Body Transform - Transform any Body Parts**

In **Pose** mode, you can only set the pose to characters. If you need to adjust detailed body parts, then switch to **Body** mode in order to fine-tune each body part with exact values.

**Stretching Animation**

1. Set the character’s pose in the **Pose** mode.
2. When the **Body Key Editor** displays, click the **Body** button.
3. The dummy pane will change to a detailed one.
4. Click one of the body parts on the dummy pane, or click the part directly on the character. A transform handle box will appear around the body.
5. Un-proportionally scale the selected body part.

6. Modify the child node in the same manner, to get the best results.

**Detaching Animation**

In addition to editing the size, you may also move the body parts away in order to create a detaching animation.

1. Select a character and open the **Body Key Editor** panel.
2. Go to a desired time frame where a body part starts to detach from the character and set a pose.
3. Go to another time frame and move the body part away (You may optionally resize the body part).

**Using Face Mode - Facial Features**

If you are using a sprite-based face, then you may use the **Face** mode for a more dramatic face effect. You can do this by moving, scaling or rotating the facial features. Please note that this function only applies to **Sprite-based faces**.

1. Select a character whose expression is already set.
2. Click the **Face** button. The dummy pane will change to the face feature mode.
3. Pick on the face dummy or directly click on the facial feature to select it.
4. Move, scale or rotate the facial feature.

1. Select a character and open the **Body Key Editor** panel.
2. Go to a desired time frame where a body part starts to detach from the character and set a pose.
3. Go to another time frame and move the body part away (You may optionally resize the body part).
**Default Pose and Absolute Key**

Inside the Motion Editor panel, you may use the Default Pose and Absolute Key to set transform keys to all body parts and facial features.

- **Default Pose**
  1. Given a character whose body has been transformed many times, it is sometimes hard to reset everything manually.
  2. To do this, go to another time frame and click the Default Pose button in the Motion Key Editor Panel. All body parts will then return to their initial status.

- **Absolute Key**
  1. You may then use the Absolute Key feature to help you set a key to retain the current transform data. This helps so that the current pose is not destroyed by the auto transition feature when the pose is between two body motion keys.
  2. Select a character, go to forward frame and set an ending pose.
  3. The transition effect will auto-generate.

  If you change the ending pose as shown in the illustration, then the transition animation will be auto produced as shown in the right image.

4. If you wish to keep the middle pose in Step 2, then you must click the Absolute Key button in Step 2 to retain the pose.

5. Modify the ending pose key. The result should be as below:

**Saving a Pose**

After setting a character's pose, you may sometimes want to share the pose with another character. Instead of adjusting the new character again, you may use the Save Pose feature to easily share the same pose.

1. Select a character whose pose is already set.
2. Click the Save Pose button in the Motion Key Editor Panel. Save the pose as a new motion file (.ctMotion).
3. Drag and drop the new motion file onto another character. The characters are now all sharing the same pose.

**Note:**

Please note that the Pose file is basically a one frame motion file with the same file extension (.ctMotion). It only stores Transform, as well as Sprite Switch, keys of body parts. All the facial features are not included.
Taking 2D Animation to the Next Level

**Utilizing the Action Menu for Body Motion**

CrazyTalk Animator provides a feature for you to embed motions to a character. Simply use the right-click menu to command the character to act the motion. The character can then be saved together with all the action commands.

- **Using the Action Menu for Motions**
  1. Select a character containing an action menu with body motions.
  2. Click the **Action Menu** button.
  3. Select one of the commands in the menu.
  4. The character will then start to perform the motion command.

**Camera Animation**

- **Using Live Camera**
  Most of the time you pan, zoom and rotate the **Preview Camera** to build a scene, and to add and edit characters and props without setting any keys to the camera. However, if you need to produce a story with camera movements for dramatic tension, then you can use the **Live Camera**.

  **Switching Camera**
  1. Build a scene.
  2. Click on the **Camera Switch Mode** button.
  3. The working area will then switch to the **Live Camera** view. You can figure out the source of the view by the icon on the top-right.
  4. Click the **Camera** button again to switch back to the **Preview Camera** view.

**Using Live Camera**

In the **Live Camera** mode you can pan, zoom and rotate the camera to auto-set a transform key to the animation camera.

1. When you are in **Live Camera** mode, click the **Zoom**, **Move** or **Rotate** button.
2. Go to another time frame.
3. Enter values in the number fields of the panel to auto-set a key to the camera.
   - You may use hotkeys to quickly set values instead of typing.
   - **Zoom**: Alt + Both mouse buttons (or Alt + Rolling the mouse wheel - can not be undo)
   - **Move**: Alt + Left mouse button
   - **Rotate**: Alt + Right mouse button
   - **Linear**: Camera moves at a constant speed.
   - **Smooth**: Camera moves at a slow-fast-slow pace to smooth its movement.
   - Click the **Default Key** button to set a neutral key to the camera.

4. Repeat the steps until you complete the camera movements in the story.

**Using Timeline**

**Introducing the Timeline**

Click the **Timeline** button on the play bar to open the **Timeline Editor**. The **Timeline Editor** is where you edit animation keys and clips for actors, props, cameras, image layers, sounds, music, etc.

---

[Images of the CrazyTalk Animator interface are shown throughout the text, each highlighting different features such as the action menu, preview camera, and timeline editor.]

---
CrazyTalk Animator

Taking 2D Animation to the Next Level

1. Next, Previous (Tab, Shift + Tab) Click these two buttons to snap the play head back to the previous, next key or start-frame clip. The key or clip will be automatically selected.

2. Add key The Add Key button only works for the Transform, Opacity tracks, the Head, Face, Eye and all sub-tracks under the Facial and Motion main tracks. Double-click on the timeline cell area to add a key, or press this button. Keys can also be automatically added when users alter any key information in the Modify Panel.

3. Cut/Copy/Paste/Delete Cut: Click the Cut button to cut the target key, or clip, in the clipboard. Copy and Paste: Click on the copy and paste button, or use hotkey Ctrl + C on selected keys or clips to copy, and Ctrl + V to paste to the target frame single or multiple keys. Delete: Click on the Delete key or Delete button to delete highlighted keys or clips.

4. Group and Ungroup Click the Group button to collect keys into one clip for easily copying and moving. Click the Ungroup button to extract the keys inside of a clip and bring them into corresponding tracks. Both buttons only work in the sub tracks under Facial and Motion button.

5. Break The Break button works for Clip type data in all tracks/groups except for clips in the SoundTrx item. Click the Break button to split the selected clip at a current frame into two new clips.

6. Loop/Speed Switch The Loop/Speed Switch button works to Clip data in all tracks/groups except for clips in the SoundTrx item. Press the Loop/Speed Switch button UP and drag the clip’s right edge rightward to decelerate/accelerate the speed. Press the Loop/Speed Switch button DOWN and drag the clip’s right edge rightward to repeat the clip.

7. Music Modify Click this button to show a panel to modify the clips under the SoundTrx item.

8. Zoom In/Out, Actual size, Fit window Click the Zoom In/Out buttons to increase or decrease the time (cell) unit size. Click the Actual Size button to show the time unit represented as 30 frames per second. Click the Fit window button to view all the timeline items within the timeline window space.

9. Play and Stop Click the button to play the project, click again to pause. Click the button to stop playing.

10. Current Frame This field shows the current frame number on the timeline. You may also type-in the frame number to jump to the target frame. This allows you to go to your precise target location; this is especially convenient for animation with clear timing control.
### D. Time Scrub

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Time Unit Bar&lt;br&gt;Drag the bar to move the displayable range to a desired time frame. Drag the right edge to change the size of the displayable range.</td>
</tr>
<tr>
<td>2</td>
<td>Play back and Export Range&lt;br&gt;Drag the two flags to decide the range for playing back or exporting.</td>
</tr>
<tr>
<td>3</td>
<td>Play Head&lt;br&gt;Drag to move to the desired time frame.</td>
</tr>
</tbody>
</table>

### Dockable Timeline

The floating Timeline can be docked under CrazyTalk Animator main program.

- Double-click the area in the illustration to dock the Timeline.
- Double-click the same area again to undock.

### Key/Clip Selections

- **Select single key** - Single click on the target key/clip, the selected key/clip will then be highlighted in red.
- **Tab Key** - Press Tab to jump to the next key/clip. Shift + Tab to jump to the previous key/clip.
- **Select All keys** - Double-click on the target track name.

### Multiple key/Clip selection

- Drag the cursor in the specific track to highlight the key/clip or clips covered under it.
- Use Ctrl + LMB (Left Mouse Button) to select multiple key/clip or clips.
- Use Shift + LMB to select the adjacent key/clip or clips.

### Clip and Key Priority

Facial expressions could come from different tracks. Therefore, during playback, the program must have a specific priority when a time frame contains data from different tracks.

#### Sprite-based head

The facial expressions generated for the Sprite-based head can be from the Tracks, the Motion Clip clips, the Face Clip clips, the Face track keys, the Voice Clip clips and the Lip track keys. When the project plays and meets all these clips or keys, then there is a certain priority for displaying the effect from these tracks.

- **General Facial Features**
  - Keys in the S track > Clips in the Facial Motion track > Clips in the Facial Clip track > Keys in the Face track.

- **Mouth**
  - Keys in the S track > Clips in the Voice Clip track > Keys in the Lip track > Clips in the Facial Clip track > Keys in the Face track > Clips in the Facial Motion track.

#### Morph-based head

The facial expressions generated for the Morph-based head come from the Face Clip clips, the Face track keys, the Voice Clip clips and the Lip track keys.

- **Mouth**
  - Keys in the S track > Clips in the Voice Clip track > Keys in the Lip track > Clips in the Facial Clip track > Keys in the Face track > Clips in the Facial Motion track.

### Note:

It is highly recommended that you ungroup the clips in the tracks mentioned above, in order to find the timing relation between keys, and adjust them into track priorities.
**Clip Editing**

**Speed, Loop and Blending**

In **CrazyTalk Animator**, you may change the speed and loop status of any clip in any track of the timeline (Facial animation, Sound FX and Music tracks excluded). Adjusting the length of the speed, loop and blending is possible.

**Speed**

1. On the timeline, select any track where a clip exists.
2. Pick the clip.
3. Press the **Loop/Speed Switch** button **UP** on the timeline.
4. Drag the end (right edge) of the clip to change its speed. The longer the clip, the slower it is and vice versa.

**Loop**

1. On the timeline, select any track where a clip exists.
2. Pick the clip.
3. Press the **Loop/Speed Switch** button **Down**.
4. Drag the end (right edge) of the clip to change its loop time. The clip then shows a series of connective rectangles, each rectangle represents one loop.

**Blending**

Each clip possesses a blending part at the head of the clip. Follow the steps below to have two motions blend with each other:

1. Have two clips applied (Motion clips as example). The illustrations below show the poses of the character at the end, and start, of the two clips.

2. The interval pose of the character remains the same as the last pose of the previous clip. It will suddenly snap back to the pose of the latter clip when the play back meets the start of it (meets previous clip).

3. Pick the previous clip. The blending part will be shown before the clip. (Empty rectangle)
4. Drag the left edge of it to decide the start timing for the blending pose.
5. The character gradually changes the pose during the interval duration.

**Grouping and Ungrouping**

When you set up voice and lip sync keys for a character, or add a lot of **Transform** and **Sprite Switch** keys to create an animation for **Characters** or the **Props**, then it is a real-time-consuming task to move a range of keys from one time duration to another. It also takes a lot of time to manually move these keys one by one.

In the **Timeline**, you can use the **Group** or **Ungroup** features to quickly achieve this.

**Main Types for Grouping and Ungrouping**

- **Head**: **Voice Clips, Facial Motion Clips, Transform Sprite Clips** (all sub-tracks included).
- **Body**: **Motion Clips, Transform Sprite Clips** (all sub-tracks included).
Taking 2D Animation to the Next Level

Ungrouping Clips

1. Select any clip in the Master or Main Tracks.
2. Drag it to another time frame.
3. Ungroup it to dissect all the keys inside of the clip into corresponding sub-tracks.
   - Ungroup by clicking the Ungroup button on the timeline toolbar.
   - Right-click on the clip and select the Ungroup command from the menu.

Grouping Keys

1. Select a character or a prop. Use the Motion Key Editor (for characters), the Prop Key Editor (for props), and the Sprite Editor (for characters and props) to add keys.
2. You will see a lot of keys shown on the sub-tracks, under the Voice Clip, Facial Clip, Face Motion and Motion tracks in the timeline.
3. In the Master or Main Tracks, drag to form a range that captures all the transform keys, and sprite switch keys, under them.
4. Group the keys to form a new clip:
   - Group by clicking the Group button on the timeline toolbar.
   - Right-click in the range and select the Group command from the menu.

Breaking Clips

The Breaking Clips method applies to all the clip-type data in the timeline main tracks (main tracks under SoundTrax are excluded). With this feature you may extract partial clips from a very long clip and delete the redundant clips.

Breaking Clips

1. Select the character. In this example, the character already moves along a path without any body motion.
2. Use the Body Puppeteering Panel to record and produce a motion clip.
3. If you do not want the last half-motion, then press F3 to launch the Timeline.
4. Click the character's Body Motion main track button. You will see the clip in the track.
5. Drag the play head to the time frame where you need to break the clip up into new half clips.
6. Click the Break button on the Timeline toolbar.
7. The clip will be divided into two halves.
8. Select the second one and delete it.
9. Play back the project and the character's motion will stop at the end of the trimmed clip.

Using Tracks

Collecting Expressions or Motion Clips

Collecting Clips for a Character

In addition to using the templates from the Content Manager, you are also allowed to make custom clips, to apply to any character, or define the clip as one of the commands in the action menu.

1. Select a character that already has expressions and motions.
2. Click the Show Timeline button (Hotkey: F3).
3. Press the Collect Clip button down to show its track.
4. Drag to make a range to collect the current motions or expressions into a clip.
5. Right-click within the range. A menu will pop up.
   - Export Motion: Merge and export all the keys and clips in the Sub-tracks (under the Body Motion main track) within the range as a *.ctMotion file.
   - Export FCS: Merge and export all the keys and clips in the Sub-tracks (under the Facial main track) within the range as a *.ctFcs file.
   - Export Perform: Merge and export all the keys and clips in the Sub-tracks (under the Facial and Body Motion main tracks) within the range as a *.ctPerform file.
Taking 2D Animation to the Next Level

Collecting Clips for Props

If you create a prop (containing single or multiple sprites) with animations, and you want to export the animation, then you may use the steps below:

1. Select a prop (Multiple sprites) with Sprite Transform or Sprite Switch animations.
2. Click the Show Timeline button (Hotkey: F3).
3. Press the Collect Clip button down to show its track.
4. Drag to make a range to collect the current animations into a clip.
5. Right click within the range and select Export Motion. Save it as an animation file (*.ctAnim)

Applying Animations to Props

If you have exported the animation of a prop, then you may apply this animation to any other props.

Please note that the number of sprites of a new prop must be equal to the prop from which you export the animation.

1. Select a new prop.
2. Drag and drop the exported animation onto the new prop.
3. The new prop will then start the animation.

Motion Layer Tracks

The Motion Layer tracks are important tracks for fine-tuning an actor's motion. You may generate simple Key Frame Animation or add Animation Layers to an existing animation clip. Basically, all the sub-tracks under the main Motion track are motion layer tracks.

Key Frame Animation

To fully understand Key Frame Animation, you will need to remove all the motion clips in the Motion main track. Then create your own key by key motion for the actor.

Follow the steps below to generate Key Frame Animation.

1. Select a character, and go to the desired time frame to create the first motion key with the Body Key Editor.
2. In the Body Key Editor window, utilize the Pose and Body mode to set a motion key.
3. Go to another time frame.
4. Add another key.
5. Play the project to see the results. The transition effect will automatically be generated between these two keys.

• Motion Clip and Sprite Switch

Given an existing motion of a character - before the motion is modified with a Sprite switch.

The motion will be modified after being affected by a Transform key.

• Motion Clip and Sprite Switch

Given an existing motion of a character - before the motion is modified with a Sprite switch.

The motion will be modified after being affected by a Sprite switch.

• Motion Clip and Transform Key

Given a motion on a character before the motion is modified with a Transform key.
## Modifying Sound Clips

**CrazyTalk Animator** provides three tracks for adding audio files. After the audio files are loaded, you may adjust the basic settings for the individual audio clips.

### Importing Sound

1. Click the **Import Sound** button in the **Stage** Mode.
2. Select the target track you want the sound to be put in to.
3. Open the **Timeline** and show all the tracks of the **SoundTrax**.

### Modifying Sound Clips

1. Select the target sound clip.
2. Click the **Music Modify** button on the timeline toolbar.
3. Drag the slider to decide the **Volume**, **Fade In** and **Fade Out** percentage.

## Introducing the Export Page

**CrazyTalk Animator** now offers the convenient feature of exporting your project into multimedia formats that are compatible with a wide range of devices. For instance, you can now convert your work to an **AVI** file with **DVD** and **HD** quality. You can also convert it into sequential image (**BMP/JPG/TGA/PNG**) files to broadcast on a web server. Exporting **Flash** files is also supported so you may output your projects as flash animation.

### A. Media Types

#### Mode Tabs

- Output Video/Widget/PopVideo/Wave Files
- Output Sequenced Images and GIF Animation Files
- Output FLV Files for Web

### B. Format and Quality

In this section, you may choose the image, video and audio quality output.

- Utilize the **Format** drop-down list to decide the format of the exporting media.
- Drag the **Video** and/or **Audio** sliders to set the quality of the exporting media.

**Note:**
- By default, the export format is **WMV** however, if you want to further edit the exported video with an external video editor, please choose **AVI** raw data for lossless post production; this maintains color fidelity for high quality production.
- If you wish to export as a **Gif Animator**, **iWidget** or **popVideo** with transparent background, then please remember to set the background in solid color.
- If you want to export into a WMV file format, then you will need to first download and install the WMVEncoder9 from the Microsoft website.
C. General Settings

In this section you may set projects as 3D media and set other general settings.

- **3D Output**: Creating a 3D Stereo media.
- **General Settings**: Specifying general export settings for exporting.

D. Export Tools

<table>
<thead>
<tr>
<th>Export Buttons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Preview" /></td>
<td>Click this button to preview the current frame results.</td>
</tr>
<tr>
<td><img src="image2" alt="Launch" /></td>
<td>If you have installed Realusion WidgetCast, then this button will be enabled. You may then click it to export your project directly into this program.</td>
</tr>
<tr>
<td><img src="image3" alt="Export" /></td>
<td>Click this button to export your project in accordance to your settings.</td>
</tr>
</tbody>
</table>

Indispensable Content for any Animator!

- **Actor Composer Library – Comical Style & Headgear**
  - 46 Accessory Props for Actors
  - 43 Head Sprites with perform elements
  - 6 Glow & Smoke Effect Props
  - 8 Assembled Heads

- **Outdoor Scene Series – Town & Country**
  - 42 Composable Scene Props
  - 10 Town, Country & Transportation Scenes

- **Real Life Character Body – Common Folks**
  - 22 Accessory Props for each character
  - 11 Common Characters

- **Digital Hosts – DigiDudes**
  - 5 Characters
  - 5 Pairs of Hands (24 Hand Gestures Included)

Perfect content solution for all CrazyTalk Animator beginners! Check out our website for more info: [www.realusion.com/contentstore](http://www.realusion.com/contentstore)